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Welcome to MAGic 
MAGic is a software solution ideally suited for vision-impaired 
computer users, or anyone who spends extended periods of 
time in front of a computer screen.  

In addition to magnifying your computer screen, MAGic also 
reads your programs and documents clearly and audibly. MAGic 
synchronizes magnified print with speech. MAGic also 
highlights words and lines as it speaks them.  

MAGic lets you enlarge Microsoft Windows application screens, 
dialogs, and windows from 2 to 16 times their normal size. You 
see and hear what you are typing, as well as, the menus, 
buttons, and other window controls. 

MAGic tracks your mouse and movements through menus, 
dialogs, and more. Screen locators give you a visual reference 
of magnified views in relationship to the unmagnified portion 
of your screen.  

The MAGic multi-directional panning system gives you 
complete control during screen review with adjustable speed, 
direction, stop and start, and screen navigation controls. 

For easier viewing, you can reverse screen colors and add color 
and other enhancements the mouse pointer. 

This demonstration copy of MAGic will run for forty minutes per 
session.  At the end of the forty minutes, MAGic will shut 
down. Restarting the computer enables MAGic to run for 
another 40-minutes. The MAGic demo gives you all the 
functionality of the full product. This demonstration version 
expires on the date printed on the program disk.   
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To purchase a full version of MAGic 8.0, contact the Freedom 
Scientific sales department or your local dealer. Freedom 
Scientific can be reached by phone at (727) 803-8000 or 
within the U.S. at (800) 444-4443 or by emailing 
info@FreedomScientific.com. 

System Requirements 
The recommended system requirements are listed below.  

Specification Minimum Requirement 

MAGic Standard Windows 95, 98, Me 
and XP Home 

MAGic Professional Windows 95, 98, Me, 
NT, 2000 and XP Home 
and Pro 

Processor speed 166 MHz 

RAM 64 MB 

Available hard disk space 
for installation 

75 MB 

Available hard disk space 
after installation 

45 MB 

Video Super VGA display* 

Sound 

Windows compatible 
sound card (for speech 
option) 

* While MAGic will work with 256 colors, we recommend that 
you use high or true color depth (16-bit color or higher) to give 
better color contrast. 
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Installing MAGic 
1. Insert the MAGic CD into your CD-ROM drive. 

2. The MAGic Setup program starts. You will hear the 
installation speak the instructions as they appear on 
your screen. Follow these instructions to complete the 
MAGic installation. 

If your MAGic installation CD does not start automatically, click 
the Start button, select Run, and type D:\setup. If your CD-
ROM is not D, substitute the correct drive letter. 

The MAGic setup program will then begin. 

Choose to run the Automatic or Guided installation of MAGic. 
The Automatic installation assumes that you want to install all 
languages, and you approve of the default location where 
MAGic installs on your hard drive. If you want to specify which 
languages to install and/or where MAGic is stored on your 
computer, use the Guided installation.   

Uninstalling MAGic  
To uninstall MAGic go to the Program Menu and select the 
Uninstall MAGic option in the MAGic 8.0 submenu. 

Getting Started 
Opening MAGic 
MAGic gives you a variety of ways to launch the program.  

• Press the hot key, ALT+CTRL+M, which is automatically 
assigned when you install MAGic.  

• Double-click the MAGic icon on your desktop.  

• Go to the Start menu, select Programs, and then select 
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MAGic 8.0, and select MAGic from the MAGic 8.0 
submenu.  

After you open MAGic for the first time, you can set MAGic to 
begin running when Windows starts. To make this selection, 
choose Run MAGic at Startup from the File menu. 

Closing MAGic  
Close MAGic like any other Windows application by pressing 
ALT+F4, point and click the X in the top right hand corner of 
the window, or select Exit from the File menu. As you exit, 
MAGic prompts you to save any settings that you changed. 
MAGic also confirms that you want to close the program. 

Magnification and Speech 
MAGic 8.0 combines great magnification features with true low 
vision screen reading, giving you the ability to choose the 
information you want read from the screen as you navigate 
your applications.   

When you install MAGic, Eloquence software speech 
synthesizer is also installed to work with MAGic. You can use 
magnification, speech, or both. Additionally, you can customize 
both the magnification and speech properties of MAGic.  

Here are a few hot keys to get you started with MAGic. By 
default the MAGic Key is the CAPS LOCK key. 

• To toggle magnification on or off, press the MAGic 
Key+DELETE. 

• To increase magnification level, press MAGic Key+NUM 
PAD PLUS. 

 

• To decrease magnification level, press MAGic Key+NUM 
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PAD MINUS. 

• To toggle speech on or off, press MAGic Key+SHIFT. 

• To silence current speech press CTRL. 

The MAGic user interface also easily lets you control 
magnification and speech.  

 

 

 

Magnification 
Level 

Smoothing 

Typing 
Echo 

Mouse 
Echo 

Speech 

View Combo 
Box 

Resize View 

Magnification 

Locator 

Inverse 
Colors 

Mouse 
Enhancements 

 

Getting Help  
Online Help System 
To access MAGic’s online help system, select Help Topics from 
the Help menu, which is located on the menu bar of the MAGic 
application window. Use the Table of Contents to navigate the 
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help system. Use the Index or the Find tabs to search for 
specific topics within the help system. If you want MAGic to 
read the help topics to you, position the mouse pointer toward 
the beginning of the help page, and press  

MAGic Key+SPACEBAR. To move to the next topic, press the 
period key, and to move back a topic, use the comma key. 
Additionally, for your convenience, the back button, as shown 
below, will take you directly back to the topic you read prior to 
the one currently displayed.  

 

What’s This? Help 
MAGic’s What’s This? Help is context-sensitive help that you 
can use as a reference when working with MAGic’s user 
interface or dialog boxes. Press SHIFT+F1 on any button on the 
user interface, or control in a dialog box to see a brief 
description of the purpose of the control and how to use it.  

MAGic User’s Guide 
The full product version of MAGic 8.0 comes complete with the 
MAGic User’s Guide. The MAGic User’s Guide, printed in large 
text for easier reading, contains the content of the MAGic 
online help along with the Quick Start Guide to get you started, 
detailed description of MAGic’s features, and pull out reference 
cards. 

Technical Support 
If you do not find the answers to questions or problems that 
you have, contact Freedom Scientific Technical Support, (727) 
803-8600. 
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About MAGic  
Select About MAGic from the Help menu on the MAGic user 
interface to view the version number of MAGic you are 
currently running. 

Hot Keys 
General 

Launch MAGic ALT+CTRL+M 

Display/Hide MAGic User 
interface 

MAGic Key+ 
NUM PAD STAR 

Pass through key MAGic Key+3 

Refresh Screen  MAGic Key+ESC 

 

Magnification Hot Keys 
Magnification, Views, & Color 

Increase Magnification  
MAGic Key+NUM PAD 
PLUS or CTRL+EQUALS 

Decrease Magnification 
MAGic Key+NUM PAD 
MINUS or CTRL+DASH 

Magnification Toggle 
On/Off MAGic Key+DELETE 

Switch between Magnified 
Views 

MAGic Key+ 
NUM PAD SLASH 

Inverse Color (toggle) MAGic Key+F12 
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Panning and Screen Movement 

Pan Right MAGic Key+RIGHT ARROW 

Pan Left MAGic Key+LEFT ARROW 

Pan Down MAGic Key+DOWN ARROW 

Pan Up MAGic Key+UP ARROW 

Increase Speed during 
Panning 

NUM PAD PLUS or 
CTRL+EQUALS 

Decrease Speed during 
Panning 

NUM PAD MINUS or 
CTRL+DASH 

Move to Left Edge of 
Screen in Magnified 
View MAGic Key+HOME 

Move to Right Edge of 
Screen in Magnified 
View MAGic Key+END 

Move to top of Screen MAGic Key+PAGE UP 

Move to Bottom of 
Screen MAGic Key+PAGE DOWN 

Move to Beginning of 
Next Line MAGic Key+ENTER 

 

Tracking 

Tracking Toggle On/Off  MAGic Key+R 

Reposition Mouse MAGic Key+NUM PAD 5 

 

 

Locator Mode 
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Start Locator MAGic Key+F10 

Stop Locator ESC 

Move Left LEFT ARROW 

Move Right RIGHT ARROW 

Move Up UP ARROW 

Move Down DOWN ARROW 

Move to End of Line END 

Move to Beginning of 
Line HOME 

Move to Top of Screen PAGE UP 

Move to Bottom of 
Screen PAGE DOWN 

 

Speech Hot Keys 
General 

Silence Current Speech CTRL 

Enable/Disable Speech MAGic Key+SHIFT 

Language Toggle MAGic Key+F11 

Note: On multi-language systems, the primary language by 
default is the language of the operating system. When 
you choose a second language, use MAGic Key+F11 to 
toggle between the primary and secondary language. To 
set another language, do so in the Voices dialog, activated 
from the Speech menu on the MAGic user interface. 

 

Document Reading 
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Say All From Location MAGic Key+SPACEBAR 

Say Active Window  
MAGic Key+SPACEBAR 
(twice) 

Say Title Bar MAGic Key+T 

 

Text Reading 

Say Current Block or 
Label from Location MAGic Key+CTRL 

Say Current Word MAGic Key+ALT 

Spell Current Word MAGic Key+ALT (twice) 

Note: When you use Say Current Block or Label from Location, if 
you move the mouse it reads where the mouse lands, 
although if you move the insertion point, it reads from the 
location of the insertion point. If you have Read Uniform 
Block of Color selected from the Text Reading Page of the 
Document and Text Reading Dialog, you can select text 
and use Say Current Block or Label from Location to read 
the selected text.  

 

Mouse Echo 

Mouse Echo Toggle MAGic Key+M 

Note: Toggling the mouse echo rotates between Speak Lines, 
Speak Words, and Mouse Echo Off. 

 

 

Some actions in MAGic do not have hot keys assigned. You can 
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define hot keys for many of these features from within the 
Keyboard Assignments dialog. 

Windows Shortcut Keys 
General 

Get Help F1 

Open the Start Menu 
Windows logo key or 
CTRL+ESC 

Open Windows Explorer Windows logo key+E 

Open Run dialog Windows logo key+R 

Find file or folder from 
Desktop F3 

Minimize all applications Windows logo key+M 

Switch between 
applications ALT+TAB 

Quit the active application ALT+F4 

 

For Windows and Menus 

Open the application 
control menu ALT+SPACEBAR 

Move to the Menu bar ALT 

Choose a menu item ENTER 

Move between menus ALT, arrow keys 

Cancel or close a menu ESC 

Cancel or close a cascading 
menu ALT 
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Open a child window 
control menu ALT+HYPHEN 

Close a child window ALT+F4 

Open the applications 
menu 

Applications key or 
SHIFT+F10 

 

For Dialogs 

Move through dialog 
controls TAB 

Move backward through 
dialog controls SHIFT+TAB 

Move to another page CTRL+TAB 

Reverse direction through 
pages CTRL+SHIFT+TAB 

Move to first item HOME 

Move to last item END 

Select or clear in list view 
SPACEBAR or 
CTRL+SPACEBAR 

Toggle a check box on/off SPACEBAR 

 

For Reading Text 

Move left one character LEFT ARROW 

Move right one character RIGHT ARROW 

Move left one word  CTRL+LEFT ARROW 

Move right one word  CTRL+RIGHT ARROW 

Move to beginning of line HOME 
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Move to end of line END 

Move up one paragraph CTRL+UP ARROW 

Move down one paragraph CTRL+DOWN ARROW 

Scroll up one screen PAGE UP 

Scroll down one screen PAGE DOWN 

Move to beginning CTRL+HOME 

Move to end CTRL+END 

 

For Editing Text 

Copy CTRL+C 

Cut CTRL+X 

Paste CTRL+V 

Undo CTRL+Z 

Delete current character DELETE 

Select one character prior BACKSPACE 

Select one character left SHIFT+LEFT ARROW 

Select one character right SHIFT+RIGHT ARROW 

Select one word left 
CTRL+SHIFT+LEFT 
ARROW 

Select one word right 
CTRL+SHIFT+RIGHT 
ARROW 

Select to beginning of 
line SHIFT+HOME 

Select to end of line SHIFT+END 

Select to beginning CTRL+SHIFT+HOME 
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Select to end CTRL+SHIFT+END 

Select all CTRL+A 

 

For Windows Explorer 

Delete files DELETE 

Rename a file or folder F2 

Open properties ALT+ENTER 

Refresh a window F5 

Switch between windows F6 OR TAB 

Go up a level BACKSPACE 
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